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Class 8

1. Basic Concepts of Computer Network
Let’s Relate (Page-5)
	 1. NETWORK, 2. INTERNET, 3. DEVICES, 4. PROTOCOL, 5. MULTIMEDIA

Brush Up (Page-9)
	 1. PAN, 2. LAN, 3. MAN, 4. WAN
Exercise
A.	 1. (c), 2. (d), 3. (c), 4. (c), 5. (a)
B.	 1. workstations, 2. modem, 3. router, 4. topology, 5. 3KHz, 3GHz
C.	 1. T, 2. T, 3. F, 4. T, 5. T
D.	 1. A computer network consists of a group of computers, user terminals 

and other system components that are linked together to share the 
resources. These shared resources can be data files, any application 
software or hardware like printers, modems, etc. 2. In order to establish 
a computer network, we need various devices which are as follows: (i) 
Workstations– In networking, individual computers that are connected 
to each other are called workstations. They are also called nodes. (ii) 
Server– The main computer that controls the whole network is called 
server. To access information over the network the workstation should 
have access to the server. The speed of the network depends on the 
capacity of the server. (iii) Modem– Modem stands for modulator-
demodulator. Modem is required to convert the analog signal to digital 
signal and vice versa to make transmission of data possible. 3. Personal 
Area Network (PAN)– PAN is a computer network that is mainly created 
for an individual person. It provides a network range within a person’s 
range typically within a range of 10 metres (33 feet). A Personal Area 
Network typically involves a computer, phone, tablet, printer, PDA 
(Personal Digital Assistant) and other entertainment devices like 
speakers, video game consoles, etc. Campus Area Network (CAN)– A 
campus area network (CAN) is a network of multiple interconnected 
local area networks (LAN) in a limited geographical area. A CAN is 
smaller than a wide area network (WAN) or metropolitan area network 
(MAN). 4. Network Topology defines an arrangement in which the 
computers are linked together to form a network. Arrangement of 
nodes is emphasized here through using the way of switches, routers 
and connections in a network. The different types of network topologies 
are as follows: (i) Bus Topology– In a bus topology, all the nodes are 
connected to a central cable called bus. In bus topology, a bus is a single 
continuous cable. Transmission from any node travels the length of the 
bus in both directions and can be received by all the other nodes in 
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the network. The bus has terminators at either ends which absorbs the 
signal, removing it from the bus. Advantages of Bus Topology– • It is 
quite easy to set up. • Failure of one node does not affect the rest of the 
network. Disadvantages of Bus Topology– • A signal on the bus must 
be strong enough to reach the receiver. • It offers limited flexibility for 
change. (ii) Ring Topology– In ring topology, all computers are linked in 
a circular way so that these make a closed loop circuit. Ring topology 
is used in LANs and WANs both. When a computer sends a message, it 
traverses along circular path as node by node till it finds the destination 
node. Advantages of Ring Topology– • Ring topology works well where 
there is no central site computer network. • Ring topology is moderately 
easy to install. Disadvantages of Ring Topology– • Ring topology 
requires more complicated control software. • Failure of one node 
results in the failure of the entire network. 5. Infrared waves are used 
for short range communication in a variety of wireless communications, 
monitoring and control applications. These travel in straight line and 
cannot penetrate through solid objects and are therefore used in home-
entertainment remote control devices. Cordless mouse and intrusion 
detectors are some of the devices that utilize infrared communication.

2. Introduction to Database Using MS Access 2016
Let’s Relate (Page-17)
	 1. DATA, 2. DATABASE, 3. TABLE, 4. MS ACCESS

Brush Up (Page-24)
	 1. (e), 2. (a), 3. (d), 4. (c), 5. (b)

Exercise
A.	 1. (b), 2. (a), 3. (d), 4. (c), 5. (a)
B.	 1. database, 2. Data redundancy, 3. table, 4. Visual Basic, 5. Field Grid 

Pane, Field Properties Pane
C.	 1. T, 2. F, 3. F, 4. T, 5. F
D.	 1. (i) Easy Sharing of Data– DBMS allows users with authority to share 

the data in the database with multiple users. For example, in an airline 
reservation system, a database is maintained and stored (centrally) for 
the reservation and the cancellation of air tickets. (ii) Reduction of Data 
Redundancy– Data Redundancy refers to having multiple copies of the 
same data stored in two or more separate places. Most of the DBMS 
are designed to reduce data redundancy by maintaining all the data in 
a single repository (centralized location). 2. The Datasheet view enables 
the user to enter data without defining the structure or the data type 
for the table. When the data is entered in the Datasheet view, the data 
type and the size of the field is determined automatically. Design view 
enables user to design and set up the database. In this view we can set 
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up the field names, their data types and description of the tables. 3. A 
field’s data type determines what kind of data it can store. MS Access 
supports different types of data, each with a specific purpose.Two most 
common data types are :

Long Text This data type is used for lengthy text 
or combinations of text and numbers.

Up to 63,999 
characters

Number This data type stores numeric data for 
mathematical calculations.

Up to 16 
bytes

	 4. It makes data entry easier and controls the values which a user can 
enter into it. For example, if a user needs to enter a telephone number, 
Input Mask can create the characters and structure with which we are 
all familiar. As the user types, the number automatically assumes a 
phone number format: (###) ###-####. 5. To rename the field, follow 
the given steps: Step 1: Take the mouse pointer to a field that we want 
to rename. Step 2: Right-click on that field. A shortcut menu will appear.
Step 3: Click on the Rename Field option and change the field name.

3. �Creating a Query, Forms and Reports in  
MS Access

Let’s Relate (Page-34)
	 1. Table, 2. Query, 3. Report, 4. Form

Brush Up (Page-40)
	 Do it yourself.

Exercise
A.	 1. (b), 2. (b), 3. (b), 4. (a), 5. (b)
B.	 1. criteria, 2. Design, 3. Relationships Window, 4. Form, 5. Report
C.	 1. T, 2. F, 3. T, 4. F, 5. T
D.	 1. Queries are used to retrieve and process the data of a table on the 

basis of certain criteria. 2. To set the relationship between the tables, 
follow the given steps: Step 1: On the Ribbon, click on the Database 
Tools tab and select the Relationships button in the Relationships 
group. Step 2: The Show Table dialog box appears. Select the required 
table and click on the Add button. The selected table will appear as 
a small window in the Relationships window. Similarly, add another 
tables to the Relationships window. Step 3 : Click on the Close button 
to close the Show Table dialog box. Step 4 : Drag the primary key of the 
parent table (e.g., Students_Record) and drop it over the same field in 
the child table (e.g., Activity_Detail). Step 5 : The cursor changes to an 
arrow and the Edit Relationships dialog box appears. Step 6: Click on 
the Create button. Access creates the relationship between the tables. 
A line linking the two tables will appear indicating that both have been 
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linked. Step 7: Click on the File → Save button to save the relationship. 
3. There are three views in which a form can be displayed : Form View: 
Form view is used to enter or edit data. Layout View: Layout view is 
used to change the format of our form. Design View: Design view is 
used to adjust the design of our form. 4. To create a split form, follow 
the given steps : Step 1: In the Navigation Pane, click on the table we 
want to use as a form. Step 2: Click on the Create tab. Step 3: Click 
on More Forms. Step 4: Click on Split Form. 5. The top portion of the 
report, called page header, contains a custom title. The contents of this 
page header displays at the top of each page. The details lines, which 
are the lines that are printed for each record, contain only those fields 
we specify. To create a report, follow the given steps: Step 1: Click on 
the table or the query on which we want to create a report. Step 2: Click 
on the Create tab. Step 3: Click on the Report option in the Reports 
group. Step 4: The report is displayed in the Layout View. Step 5: After 
creating the report, we can save it by clicking on the File → Save button. 
We will see that the Report object gets added in the Navigation Pane.

4. Introduction to Adobe Photoshop CC 2018
Let’s Relate (Page-49)
	 Do it yourself.

Brush Up (Page-58)
	 1. Image window, 2. Adjustment Panel, 3. Tolerance, 4. Lasso tool,
	 5. Marque tool

Exercise
A.	 1. (b), 2. (a), 3. (a), 4. (b), 5. (d)
B.	 1. Tools Panel, 2. Color Panel, 3. Single Row Marquee tool, 4. three,  

5. Image window
C.	 1. F, 2. F, 3. T, 4. F, 5. F
D.	 1. There are many features of Adobe Photoshop CC 2018 . Some of 

them are : • It is a very convenient and professional image editing 
software that is equipped with loads of tools. • It has some impressive 
features like intelligent auto-correction, HDR imaging, effects, color 
management, masks, animations, brushes, histogram palettes, and 
layer control, etc. • It allows us to make quick picture corrections like 
removing the chromatic unusualness, monograph and lens distortions.  
• It is equipped with Content-Aware tools which will enable the users 
to remove content from a photo and then replace it with modest fixed. 
• It has Mercury Graphics Engine which has enhanced productivity.  
• It allows the users to perform image as well as video editing at some 
impressive speeds.



	 Computer 60

	 2. Lasso Tool: It is a freehand drawing selection tool. Polygonal 
Lasso Tool: It allows us to click points around the image to create 
the selection. Magnetic Lasso Tool: It allows us to select an object 
by tracing its outline or selecting the areas which has complex edges. 
3. We can change the canvas size of an image, by following the given 
steps: Step 1: Click on the Image tab in the address bar. Step 2: Click 
on the Canvas Size. The Canvas Size dialog box appears. Step 3: Type 
the dimensions for the new canvas. Step 4: Click an anchor point 
(such as the middle one). Step 5: Click on OK. Photoshop changes the 
canvas size of the image. 4. To move an image in workspace, follow the 
given steps: Step 1: Open the image. Step 2: Select a portion of the 
image we want to move using any of the selection tool. Step 3: Click 
on the Move Tool on the toolbox. Step 4: Place the mouse pointer on 
the selected area of the image and drag it to a new location. In case 
we have not selected any area of the image, the entire image moves 
on dragging. 5. To save a file in Photoshop CC, follow the given steps :  
Step 1: On the address bar, click the File → Save As option. The Save 
As dialog box will appear. Step 2: Select the location where we want 
to save the file and type the file name in the File name text box.  
Step 3: Select the appropriate file format for the file to be saved from 
the Save as type box. Step 4: Click on the Save button.

5. More on Adobe Photoshop CC 2018
Let’s Relate (Page-66)
	 1. Application Bar, 2. Tools Panel, 3. Options Bar, 4. Document Window
Brush Up (Page-78)
	 1. SHAPE, 2. PAINT BUCKET, 3. PAINTING, 4. PATTERN, STAMP, 
	 5. CONTENT AWARE MOVE
Exercise
A.	 1. (a), 2. (c), 3. (b), 4. (a), 5. (b)
B.	 1. Gradient, 2. Paint Bucket, 3. Brush, 4. Pattern Stamp, 5. Layers Panel
C.	 1. F, 2. F, 3. F, 4. F, 5. F
D.	 1. To use the Custom Shape Tool, follow the given steps: Step 1: Click 

on the Rectangle Tool on the Tools panel and select the Custom Shape 
Tool option. Step 2: Select a shape from the Shape pop-up panel in 
the Options bar. Step 3: Click and drag the mouse to draw the selected 
custom shape. 2. Dodge tool increases the brightness of the photo. It 
is a great tool to lighten faces hiding in shadow. Burn tool darkens the 
pixels without affecting the colors. By using this tool, we can create 
greater contrast by deepening the shadows in certain areas of photo. 
3. To use the Spot Healing Brush tool, follow the given steps: Step 1: 
Open the image to be repaired. Step 2: Select the Spot Healing Brush 
Tool from the Tools panel. Step 3: Now, adjust the following settings 
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on the Options bar: Brush Size: Adjust the size and hardness of the 
brush by clicking on the slider. Mode: Set the mode to normal. Type: 
Choose the Content Aware, Create Texture or Proximity Match. 
Content Aware works in the similar way as Content-Aware fill does 
but in a particular area only. Create Texture will add texture from 
the surrounding area. Proximity Match will look at everything in the 
vicinity and decide what texture should be inside the brush. Sample 
All Layers: Check on Sample All Layers if working with two layers only, 
one is the original image and other is new layer for editing. Step 4: 
Click over the spots to remove errors. 4. The Clone Stamp tool selects 
and samples an area of the image and then uses these pixels to 
paint over any other part of the image. It acts like a brush so we can 
change the size, allowing cloning from just one pixel wide to hundreds.  
5. A Photoshop image can consists of multiple layers, with each layer 
containing different objects in the image. When we open an image in 
Photoshop, it exists as a single layer known as the Background layer. We 
can add new layers on top of the Background layer as we work. Layered 
Photoshop files act like several image combined into one. Each layer 
of an image has its own set of pixels that we can move and transform 
independently of the pixels in other layers.

6. Images, Links, Forms and Frames in HTML 5
Let’s Relate (Page-85)
	 1. <UL> tag, 2. <H1> tag, 3. <Body> tag, 4. <BR> tag, 5. <I> tag
Brush Up (Page-90)
	 1. (c), 2. (a), 3. (b)
Exercise
A.	 1. (b), 2. (a), 3. (c), 4. (c), 5. (a)
B.	 1. align, 2. Border, 3. Name, 4. Frameset, 5. <frameset>
C.	 1. F, 2. F, 3. T, 4. T, 5. T
D.	 1. The <IMG> tag is used to add images to a web page. It is an empty tag 

which implies that it has only an opening tag that has various attributes. 
2. When we browse the Internet, we mostly see the underlined text, 
that indicates the hyperlink. A hyperlink is a link that helps to navigate 
from one document (or position) to another. Hyperlink can point to 
HTML page, image, video, audio file, text, etc. 3. The <A> tag allows 
us to link various web pages or different sections of the same page. It 
specifies the destination of the hyperlink in order to create the linking. 
The text or image enclosed within the opening and closing tags of the 
<A> tag acts as a hyperlink.

	 Syntax:
	 <A> --------------- </A>
Attribute of <A> tag are as follows:
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Href (Hyperlink Reference) Attribute: This attribute specifies the 
location of the file or resource that we want to provide a link to. 
Title Attribute: This attribute is used to give a title to any hyperlink. 
It contains some information about that link, in textual format. 
Name Attribute: This attribute allows the user to create links within 
the same document. This attribute specifies the name of the anchor 
being set up. 4. Using Input tag we can insert several elements like 
text fields, radio button, etc. in the form. Using these elements the 
information of an user is submitted on a web server. Text Field: The 
text field is a one line input field allowing the user to input text. Text 
Field input controls are created using the “input” element with a type 
attribute having value as “text”. In most browsers, the width of text 
field is 20 characters by default. Password Field: The password field is 
a type of text field in which the text entered is masked using asterisk 
or dots for prevention of user identity from another person who is 
looking onto the screen. Password Field input controls are created 
using the “input” element with a type attribute having value as 
“password”. Check Box: It enables the user to select multiple options. 
Checkbox input controls are created using the “Input” element with 
a type attribute having Value as “Checkbox”. Radio Button: It enables 
the user to select one between multiple options. Radio Button input 
controls are created using the “Input” element with a type attribute 
having Value as “Radio”. Submit Button: It is used to transfer content 
from the current page to the server. The action attribute of the form 
defines the name of the file to which the contents will be sent. This 
file usually processes the data. 5. HTML frames are used to divide the 
browser window into multiple sections where each section can load 
a separate HTML document.

7. Cyber Ethics
Let’s Relate (Page-97)
	 1. Advanced Research Projects Agency Network, 2. International 

Network, 3. Vital Information Resources under Siege, 4. Transmission  
Control Ptotocol/Internet Protocol, 5. Domain Name System, 6. Virtual 
Private Network

Brush Up (Page-102)
	 1.  Plagiarism, 2. Hacking, 3. Copyright, 4. Software piracy

Exercise
A.	 1. (a), 2. (b), 3. (a), 4. (c), 5. (a)
B.	 1. quotation marks, 2. Hackers, 3. spammer, 4. Software piracy, 5. patent 

rights
C.	 1. T, 2. F, 3. T, 4. T, 5. T
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D.	 1. Computer Ethics are the common guidelines that we need to follow 
while using the computer. These are also known as etiquettes that tell 
us how to use the internet wisely. 2. Cyberbullying is a form of bullying 
or harassment using electronic media such as smartphones, computers 
and tablets to harass or attack a person. It includes sending, posting, or 
sharing negative, harmful, false, or mean content about someone else. 
It can include sharing personal or private information about someone 
else causing embarrassment or humiliation. 3. Software piracy is the 
act of stealing software that is legally protected. This stealing includes 
copying, distributing, modifying or selling the software. 4. Intellectual 
Property Rights can be classified into four types: Copyright: Copyright is 
a term that describes ownership or control of the rights to the use and 
distribution of certain works of creative expression, including books, 
videos, movies, music, and computer programs. Patent: A patent gives 
its owner the right to exclude others from making, using, selling and 
importing an invention for a limited period of time. The patent rights 
are granted in exchange for enabling public disclosure of the invention. 
Trademark: A trademark is a graphical representation that is used to 
distinguish the goods and services of one party from those of others. A 
trademark may consist of a letter, number, word, phrase, logo, graphic, 
shape, smell, sound or combination of these things. Trade Secrets: 
Trade secret describes about the general formula of any product and 
the key behind any organization’s progress. It also includes various 
firm’s different secret formulas for the same products which differ 
in quality. 5. Digital footprint refers to one’s unique set of traceable 
digital activities, actions, contributions and communications showed 
on the internet or digital devices. In other words, a digital footprint is 
an impression of a user leaves while using the internet. It is used to 
describe the mark, traces or footprints that a person leaves when he 
use internet. A digital footprint also known as digital dossier. Digital 
footprints can be classified as either Passive or Active. Passive Digital 
Footprint– A passive digital footprint is unintended by the user. For 
example, a shopper on an ecommerce site unintentionally provides the 
site information about their preferences and lifestyle by the products 
they browse. Active Digital Footprint– An active digital footprint 
displays information that an individual purposely shares with the public 
or network of contacts such as a blog post.

8. Know More About Python
Let’s Relate (Page-107)
	 1. If statements, 2. If-else statements, 3. Nested statements

Brush Up (Page-111)
	 1. FLOAT, 2. RANGE, 3. SPLIT, 4. LEN
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Exercise
A.	 1. (c), 2. (b), 3. (a), 4. (d), 5. (d)
B.	 1. ‘def’, 2. bin(), 3. slice, 4. commas, 5. Python string
C.	 1. T, 2. T, 3. F, 4. F, 5. T
D.	 1. Python function is a block of code which only runs when it is called. 

We can pass data, known as parameters, into a function. A function can 
return data as a result. Elements of Functions– • The beginning of a 
function header starts with the keyword ‘def’ followed by the function 
name and parentheses. • We pass arguments to the defined function 
using parameters. • The function header is terminated by a colon (:).  
• The body of the function is made up of several valid Python statements. 
The indentation depth of the whole code block must be the same. • We 
can use a return expression to return a value from a defined function. 
2. In Python, to call a function, use the function name followed by 
parentheses:

	 Example:
	 def welcome():
	 print(“Welcome for using me”)
	 welcome()
	 3. Python tuple is another sequence data type that is similar to the 

list. A tuple consists of a number of values separated by commas. 
Unlike lists, however tuples are enclosed within parentheses. The 
main differences between lists and tuples are: Lists are enclosed 
in brackets ( [ ] ) and their elements and size can be changed, while 
tuples are enclosed in parentheses ( ( ) ) and cannot be updated.  
4. list_name= [item 1, item 2, item 3, ---------] 5. Python string is the 
collection of the characters enclosed within quotes. Strings in python 
are surrounded by either single quotation marks or double quotation 
marks.

	 ‘Hello’ is the same as “Hello”.
	 Syntax:
			   Strng_name = “collection of characters”
	 Example:
	 str = ‘Welcome to use Python!’
	 print(str)		  # Prints complete string
	 print(str[0])	 	 # Prints first character of the string
	 print(str[4:6])	 # Prints characters starting from 5th to 7th

9. Domains of AI
Let’s Relate (Page-118)
	 1.	 George Devol, 2. David Hanson, 3. Ali Ahmed, 4. Marc Raibert
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Brush Up (Page-121)
	 1. Data Science, 2. Speech Recognition, 3. Computer Vision,
	 4. Intelligence

Exercise
A.	 1. (a), 2. (b), 3. (c), 4. (b), 5. (d)
B.	 1. hardware, software, 2. Data Science, 3. acquiring, processing,
	 4. humans, electronic 5. Natural Language Processing
C.	 1. T, 2. F, 3. F, 4. F, 5. T
D.	 1. AI Domains refer to the main branches of Artificial Intelligence. In 

AI human-machine, interactions done through the following domains:  
(i) Data Science, (ii) Computer Vision (CV), (iii) Natural Language 
Processing (NLP) 2. Data Science is totally based on the following 
concepts which are as follows: • Asking the correct questions and 
analyzing the raw data. • Modeling the data using various complex and 
efficient algorithms. • Visualizing the data to get a better perspective. 
• Understanding the data to make better decisions and finding the final 
result. 3. Computer Vision is a field of Artificial Intelligence (AI) that 
enables computers and systems to derive meaningful information from 
digital images, videos and other visual inputs and take actions or make 
recommendations based on that information. If AI enables computers 
to think, computer vision enables them to see, observe and understand. 
4. Natural language processing field is divided into three parts: Speech 
Recognition: It is used for translation of spoken language into Artificial 
Language text. Natural Language Understanding (NLU): It is used for 
spoken or written language to provide a link between natural language 
inputs and what they present. It analyses different aspects of language. 
Natural Language Generation (NLG): It helps to produce meaningful 
phrases and sentences along with Text planning, Sentence planning, and 
Text realization. 5. (i) Data Science is used by medical professionals to 
find the new ways to understand disease, practice preventive medicine, 
diagnose diseases faster and explore new treatment options. (ii) Data 
Science is used in self-driving cars to adjust the speed limits, avoid 
dangerous lane changes, and even take passengers on the quickest 
route.
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